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Introduction 
While Notes is so much more than just an email, calendar, and contacts application, these features 

are nevertheless some of the most important features of the client.  

Outlook is the email and scheduling client with the largest user base. This means that if you get new 

employees in your company, they were most likely Outlook users in their previous position. If you 

are using Notes for email and calendaring, there will be a period of adjustment for the employee. 

In the past 15 years I have held several user training sessions for users moving from the world of 

Outlook to the world of Notes. This whitepaper is therefore built on my long experience with the 

usual questions and challenges. 

This document will hopefully help you make the transition smoother and make it easier for the 

employee to adapt to working with Notes. To this end I have included tips on how you can set up the 

client to mimic Outlook behaviour (like opening everything in new windows). 

In addition, I have described how you use a lot of the functions that Outlook, and Notes have in 

common, but that might be a bit different in Notes. 

I also think this document will be of great help to users who have used Notes for years.  

Prerequisites 
While there are really no prerequisites for using this document, a basic understanding of email and 

electronic scheduling will come in handy.  

Also, it would be a good idea to give your users an overview of Notes and how you are using Notes 

and Domino inside your organisation. 

Other than that, the users should have no trouble following this document, especially if they are 

already familiar with Outlook or Notes.  
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Microsoft Outlook 
Before we start going through the Notes client, I will give a brief overview of the of the same 

functionality in the Outlook application in Windows. 

Mail 

 

 

The picture above shows the email interface in Outlook. You have a menu at the top for various 

actions you can perform: Creating new emails, replying to received emails, creating mail rules, and a 

lot of other mail-related functions. You can also change how emails are listed and sorted in the 

various folders. You can also choose whether to: 

• Hide the left side menu 

• Show the preview pane and, if so, where to display it 

• Show the right sidebar, and if so, what it should contain.  

To the left, below the top menu, you have the menu for mail accounts and folders. In Outlook you 

can add several mail accounts that will be listed in the left menu, and you can then work with the 

folders belonging to each account.  

To the right of the left menu, you find all the emails in the currently selected mail folder. You can 

perform various actions on them by right clicking and choosing from the menu items that will 

appear. You can also mark an email and use the functions in the top menu. 

In the picture above, the preview pane is to the right, but it can also be set to show at the bottom. 

Here you can see the email you have marked in the folder. You can also reply to emails in the 

preview panel, just like in Notes.  

Furthest to the right you have a sidebar where you can add a view for your calendar, for primary 

contacts (which can be connected to Teams), To do items and so on. This is customizable and you 

can set this to fit your needs via the top menu.  

To open the mail part of Outlook you click on the envelope icon in left side menu. 
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Calendar 

 

 

Just as in Notes, you have a calendar in Outlook. In the top menu you can create new meetings, 

appointments, and reminders. If you have Microsoft Teams configured, you can also create Teams 

meetings. You can also choose various calendar views (daily, weekly, work week, monthly and 

others) and whether to display the right sidebar and what it should contain. You can even turn on 

and off the preview pane or choose to show it below the calendar entries instead of to the right (in 

the photo above it’s turned off).  

In the left side menu, you see a small calendar showing this month and the next one. Click on the 

dates to set focus to them. Any meeting you create will be set to that date (which you can change). 

Below the mini calendars You can add and turn on and off the calendars of all email accounts you 

have connected to your Outlook. You can also do this with other people’s calendars (if they have 

shared them with you), group calendars (Teams and SharePoint) and external calendars that are 

open to the outside world.  

In the main calendar field, you see all the calendar entries for any given day, week, or month you 

have chosen. You can navigate back and forth via arrows. By right clicking on a calendar entry, you 

get a menu where you can do many actions like replying, cancelling, colour code and many more 

things. You can also choose whether you want all the calendars you have set up should overlap each 

other, or if they should be displayed side by side.  

If you decide to turn on the preview panel it will either show to the right of the calendar, or beneath 

it, depending on your choice. The preview panel displays the currently selected calendar entry. 

Furthest to the right you have a sidebar where you can add a view for your calendar, for primary 

contacts (which can be connected to Teams), To do items and so on. This is customizable and you 

can set this to fit your needs via the top menu.  

To open the calendar part of Outlook you click the calendar icon in the left side menu. 
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Contacts 

 

 

You also have a personal Contacts functionality in Outlook, which works similarly to the Contacts 

application in Notes.  

In the top menu you can create new contacts, as well as contact groups where you can collect 

several contacts to make it easier to send email to many people at once. You can also choose various 

ways to display your contacts or groups and you can select whether to display the right sidebar or 

not, and what it should contain. Like with calendar and email you can choose whether you want to 

show the preview pane or not, and if it should be at the bottom or to the right. 

In the left side menu, you can choose which contact list you want to show. Each of your email 

accounts have their own contact list.  

To the right of the left menu, you see all your contacts listed. You can sort them in various ways. By 

right clicking on a contact, you get a menu where you can do many actions like assigning a task, 

creating a calendar entry and a few other things.  

If you have turned on the preview pane, you see it to the right of the contact list or beneath it. The 

currently selected contact or contact group is displayed there and you can then edit it or perform 

other actions on it within the preview pane.  

Furthest to the right you can have a sidebar where you can add a view for your calendar, for primary 

contacts (which can be connected to Teams), To do items and so on. This is customizable and you 

turn it on and off and set it to fit your needs via the top menu.  

To open the Contacts part of Outlook you click the person icon in the left side menu. 
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To do 

 

 

Both Outlook and Notes have a To do app/function. Here you can set up tasks that you can assign to 

yourself or others. You can also right click an email and turn it into a task, or just drag it down to the 

To do icon at the bottom of the left side menu. The tasks can have a due date and be set to various 

priorities. You can do this by using the top menu or right clicking on a task.  

In the top menu you can change how tasks are displayed, create new tasks, create emails, and 

choose whether the left side menu, preview pane or right sidebar should be displayed and what they 

should contain. 

The left menu gives you the option to choose whether to see all tasks, regardless of which email 

account they have been created with, or if you want to see completed tasks for each mail account.  

To the right of the left side menu, you see the list of tasks. Which tasks depends on what you have 

chosen in the left side menu.  

The preview pane can be turned off or on, and if it’s turned on you can set it to the right or bottom 

of the tasks list. When you click a task, the contents are displayed in the preview pane. 

Just like with email, calendar, and contacts you can choose to display the right sidebar panel, where 

you can add calendar, contacts, and other functionality.  

To open To Do you click the check box icon at the bottom of the left side menu 

Summary 
This gives you a general idea of the functionality of Outlook, as a comparison point for HCL Notes. 

Since this is a manual for HCL Notes, we will of course take a much deeper dive into the Notes Mail, 

Calendar, Contacts and To do apps than we did in Outlook.  
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Notes client settings and functions 
In this section, you learn how you can set up the Notes client to behave as much like Outlook as 

possible. In addition, you learn general functionality in Notes that will be available no matter what 

Notes application or database you are using.     

Open documents in new windows 
In Outlook, any document that you create or open will appear in its own window. This is of course 

possible in Notes as well. 

1. Go to the menu File and choose Preferences. 
 

2. Click on Windows in the Preferences screen. 
 

3. Select Open each document in its own window under Window Management: 

 
 

4. Click Apply and then OK. 
 

5. Every window and document will from now be opened in its own window. 

PS! You can also open any Notes document in a new window at any time by right clicking on it in the 
view or folder and choose Open in New Window. 

Preview pane 
As in Outlook, you can choose whether you want to use a preview pane for your email, calendar and 

to do entries, and whether to display it at the bottom or to the right. 

Click the Show button at the upper right, above the mail, calendar or to do folder you are currently 
working with: 

http://domino.elfworld.org/wp-content/uploads/2021/03/01.jpg
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You can also control whether you want the email or document to be marked as read or not when it's 
been displayed in the preview pane: 

1. Go to the menu File and choose Preferences. 
 

2. Click on Basic Notes Client Configuration in the left side menu. 
 

3. In the big Additional Options field, check Mark documents when opened in preview pane if 
you want the emails or documents to be marked as read after being displayed in the preview 
pane. If you do not want that, uncheck this option: 

 
 

4. Click OK. 

PS! You can also mark a read document as unread, or an unread document as read, by hitting the 
Insert button on your keyboard 

Shortcuts 
In Outlook you have shortcut icons for the mail, calendar, and To do in the lower left corner. In 

Notes you have several ways to get shortcuts for Mail, Calendar, and Contacts: 

Shortcut buttons 

Click on View -> Show Shortcut Buttons and choose Mail. Then repeat this for Calendar and 

Contacts: 

http://domino.elfworld.org/wp-content/uploads/2021/03/02.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/03.jpg
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You will now see these shortcut buttons under the menu line: 

 

Unfortunately To do is not available as a shortcut button. 

Bookmarks 

However, To do is available as a bookmark, together with Mail, Calendar and Contacts. 

You find these bookmarks under the Open button: 

http://domino.elfworld.org/wp-content/uploads/2021/03/28.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/29.jpg
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You can pin the bookmarks under the Open button to be permanently visible by right clicking on the 
Open button and choose Dock the Open List. You can also choose Use Large Icons. Now Mail, 
Calendar, Contacts and To do will have permanent shortcuts to the left in the Notes client: 

 

http://domino.elfworld.org/wp-content/uploads/2021/03/30.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/31.jpg
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Spell checking 
Spell check can be done in any rich text field, both in emails, calendar and to do entries, and 

documents in other Notes applications. 

Turn on spell checking 

1. Go to the File menu and choose Preferences. 
 

2. Click on Spell Check: 

 
 

3. To activate spell checking, click on Enable Instant Spell checking. 
 

4. You can choose the default language from the list Primary Dictionary (if it is not there, 
contact your administrator to have it installed), by clicking on it and then clicking on the 
button Set as Default. 
 

5. Set any other settings you want and click OK. 

Using spell checking 
After turning it on, you can spell check text in any rich text field. Notes underlines spelling errors 

with a red line: 

http://domino.elfworld.org/wp-content/uploads/2021/03/45.jpg
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The spell check in Notes is not as advanced as in Outlook but it is still very helpful. 

Spell checking several languages at once 

Outlook automatically detects what language you write in while spell checking. So if you change 

from Norwegian to English and both of these languages are installed on your computer, it will 

change the spell checking to the language you are currently writing in. 

Notes does not do that. If you want to spell check in another language than the default language, 
you manually change to the language you want to use for spell checking. 

Here is how you can spell check more than one language at once in Notes: 

1. Write the text: 

 
2. Highlight the text you want to spell check in a different language from the default language: 

 
3. Hold down the CTRL key on your keyboard and hit the K key. Or go to the menu Text and 

choose Text Properties: 

 
 

http://domino.elfworld.org/wp-content/uploads/2021/03/46.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/47.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/48.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/49.jpg
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4. In the popup window, go to the Language field at the bottom and choose the desired 
language: 

 
 

5. The language will now be changed for the highlighted text: 

 

Rich text formatting in HCL Notes 
Rich text fields are fields in Notes where you can format the text with colours, photos, tables, 

different types of fonts and so on. The email body field (where you write the message text) is one 

example of a Notes rich text field. Rich text fields are also in calendar and To do entries and they can 

also be in any Notes applications and databases that you use. 

You can format the text in a rich text field in most of the ways that you are used to: 

http://domino.elfworld.org/wp-content/uploads/2021/03/50.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/51.jpg
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There is a toolbar for all these formatting options above the document, under the row showing all 
your open windows and documents: 

 

If you cannot see this toolbar, it could mean that it's either turned off, or that you aren't in a rich 
text field right now. You can check this in the menu View -> Toolbar: 

 

http://domino.elfworld.org/wp-content/uploads/2021/03/57.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/58.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/59.jpg
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Make sure Text Properties is checked. If you choose Show Toolbars Only When Editing, the toolbar 
will only show up when you are in a rich text field. If Hide All Toolbars is checked, all toolbars will be 
hidden all the time. 

Mail 
In this section you will learn how to use the mail application in Notes efficiently. You will see how 

you set your signature, how you can use different signatures, how to spell check, how to flag emails 

for follow up, how to sort and search your mail folders and more.  

Creating a new email 
Creating emails in Notes is very similar to how you do it in Outlook. 

1. Click CTRL + M to create a new email (or click the New button if you are in mail folder). You 
can do this even your mail application is not even open in Notes. 
 

2. To add email addresses, you can simply start typing the name or address in the To, Cc or Bcc 
field (if the Bcc field isn't displayed, click on the button called Display above the mail form 
and choose Bcc).  
 
If the email address or name of the person you are sending the email to doesn’t show up 

you can click on To:  

 
a) You now see this popup: 

 

http://domino.elfworld.org/wp-content/uploads/2021/03/66.jpg
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b) You can now select people from your company directory. If you want to add people from 
your personal Contacts, select your Contacts application in the Directory pull down field: 

 

c) You can use the Find names starting with field to type the beginning of a person's name 
to find the person you are looking for if you do not want to scroll through the list. 

d) Use the buttons to the right of the address field to add people and addresses to the To, Cc 
or Bcc fields. 

e) Click OK. 

3. You can now write your email. To add attachments, you can simply drag and drop files into 
the email. 

Sorting email folders and views 

Newest mail on top or bottom 
To make sure the newest email is always on top or bottom in your inbox or other mail folders do 

this: 

1. Go to File -> Preferences and choose Mail: 

 
 

2. Click the tab Basics 

 

3. Scroll to the bottom and choose your setting here: 

 
 

http://domino.elfworld.org/wp-content/uploads/2021/03/64.jpg
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4. Click OK 

 

5. Close Mail and re-open it again 

Sorting email by column 
You can sort your email folders by clicking on the column names at the top: 

 

 

Click Who to sort by sender alphabetically or Subject to sort by subject alphabetically. Click once 

more to go back to the standard sorting 

 If you click Date you switch between having the newest email on top or at the bottom  

If you click Size once, the largest emails are on top. If you click once more, the largest emails are at 

the bottom. If you click a third time, the folder goes back to the standard sorting. 

Clicking on recipient icon, attachments, or flagging sorts the folder based on these. If you click once 

more, it goes back to the default sorting.  

Group by Date 
Just like in Outlook you can group emails by date as well. Click on the Show button in the upper right 

of the folder and choose Group By Date: 

 

 

All emails in that folder will now be grouped like this: 
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To see the emails under any given date, click on the twisty to the left to expand the list. 

If you click the Date column to change the sorting, the grouping will reflect this. However, if you click 

any other sorting, the Group by Date sorting is paused until you sort the folder by date again.  

Unread mail only 
You can also choose to see unread mails only inside a folder. Click on the Show button in the upper 

right of the folder and choose Unread Only. Read mails are no longer displayed until you turn this off 

again. All sorting options work.  

PS! If you have a preview window, and it’s set to mark an email as unread after being previewed, it 

disappears from the folder when you move to the next email. Do not panic, just turn off Unread 

Only. 

Search for emails 
To search for emails in Notes, simply click inside the folder you want to search and start typing: 

 

In the example above the folder was sorted by Who when I started typing. You can see this by the 

fact that Who is listed in the Find in field.   

You can change this by clicking on the pulldown list: 

 

 

If you change this to Subject or Date, the folder is re-sorted in the background.  
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After choosing the column you want to search, you simply write what you want to search for and 

click on the Find button. If any email has your search expression in the start of the selected column’s 

value, it will take you to that email.   

If you choose Any column you can search for any expression in any column. It does not even have to 

start with that expression: 

 

 

The example above finds any email containing the word tickets in either Who or Subject, even if the 

column value started with another word. Example: It would find both Tickets for you, Your tickets 

and Bus tickets. 

Flag an email for follow up 
You can flag an email for follow up simply by right clicking on the email and selecting Quick Flag: 

 

You can also mark one or more emails and then hit the flagging button above the folder: 
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Under Add or Edit Flag... you can set due dates and a lot of other settings. Read all about flagging of 

emails in this blog posting. 

You can see a view of all your flagged emails if you click on Follow Up in the left side menu in your 

email. You can also see them constantly listed in the left side menu by scrolling down to the bottom 

of the left side menu.  

Click on the small arrow: 

 

PS! If you have Notes V11 or newer, you do not need to look for this small arrow. You can just 

expand the menu item called Show Mini View. 

After clicking on the arrow, you can choose Follow Up in the pulldown menu that appears: 

 

Now the list of emails you have flagged will be displayed in the left menu. 

Turn an email into a meeting or To do 
To turn an email into a calendar entry, such as a meeting invite, or a To do, right click the email and 

choose Copy Into New: 

 

https://domino.elfworld.org/notes-tips-19-flag-an-email-for-followup/
http://domino.elfworld.org/wp-content/uploads/2021/03/05.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/43.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/44.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/06.jpg
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If you click Calendar Entry you can choose what kind of calendar entry it should be. A pop up 

appears, and if you select Meeting, it prepares a new meeting document. Notes automatically 

populates the invite fields with all the people in the To, Cc and Bcc fields. 

See your calendar while using your email 
In Outlook you must actively choose to display your calendar in the right sidebar. In Notes, it's 

always there for you, and unlike Outlook it also shows entries from any imported calendars (Outlook 

only displays your main calendar). 

Simply click Day at a Glance in the right sidebar panel to see all your appointments for today: 

 

You can click the arrows to navigate from one day to the next, and you can navigate through the 

months in the calendar underneath the calendar entries. 

To get back to today, click the Today button. 

PS! If the right sidebar panel isn't visible, just click CTRL + 9 on the keyboard. 

Quick rules 
Like in Outlook, you can create quick rules based on the currently selected email: 

1. Click the email you want to create a rule from. 

http://domino.elfworld.org/wp-content/uploads/2021/03/07.jpg
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2. Click the More button above the folder and choose Create Quick Rule...: 

 
 

3. You will then get a popup window where you can choose what should trigger the rule: 

 
 

In the example above I have set it to the following: 

Under 1 I have set the condition to match the displayed Subject. 

 

Under 2 I have chosen that at least one of the selected conditions under 1 should be met.  

 

http://domino.elfworld.org/wp-content/uploads/2021/03/25.jpg
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This is not necessary here since I have only selected one condition, but you do have the 

option for selecting more than one. 

 

Under 3 I have selected that emails matching this rule should be automatically moved to the 

folder Under arbeid. You choose a folder by clicking on Select... and you can also create new 

folders in the popup window that will appear 

 

4. Bonus tip if you have Notes V10 or newer: If you want this rule to be triggered on emails 

that already are in your inbox, you click on Run Now on Inbox....If you want it to trigger on 

matching emails no matter what folder they are in you click on Run Now On All 

documents.... 

 

5. Click on OK when finished 

From now on all emails with that subject are automatically moved to the selected folder. 

You can administer your rules, as well as create even more complex rules, by clicking on the More 

button and then selecting Mail Rules -> Manage Rules: 

 

Mail signature 
You can create email signatures that are automatically added to the bottom of your emails. You can 

set up different signatures for whether it’s a new email, reply or pure text email. 

Creating the signature 
You create your email signature like this: 

 

1. Open any folder in your email. 
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2. Click the More button above the folder and select Preferences...: 

 
 

3. You will now be taken to the Mail preferences window. Click on the Signature tab: 

 
 

4. Check Automatically append a signature to the bottom of my outgoing mail messages to 

make sure the signature is always added to your emails. 

http://domino.elfworld.org/wp-content/uploads/2021/03/32.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/33.jpg
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You have the following signature types: 

 

Rich Text: Here you can add formatted text, hypertext links and images (like in the image 

above). 

 

Plain Text: Here you can add nothing but a pure text signature. This will be added whenever 

you send an email as pure text, or you manually select it before sending an email. 

 

HTML Image or file: If you choose this, you will be asked to upload an image file or an HTML 

(web) file. 

 

5. Some people like to have a different signature when they reply to, or forward, a message. 

You can therefore click on the tab Reply and Forward Messages, where you will get these 

options: 

 
 

Default: If you choose this, it will use the same signature you set for New Messages 

 

Rich Text: If you choose this you get a rich text field where you can create a totally different 

signature with formatted text, hypertext links and images 

 

Plain Text: If you choose this you can create a different pure text signature 

 

HTML or Image File: You can upload a different image or HTML file to use as a reply or 

forward signature 

 

6. Click OK when finished 

The signature is now always added to your emails. 

Different signatures 
In Outlook you can have different signatures for different purposes and email accounts. This is not 

possible in Notes, but what you can do is create image or HTML files with alternative signatures. Add 

them to a folder on your PC or network drive. 

If you want to use an alternative signature, you do it like this: 

1. Create a new email or reply to an email. 
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2. Place your cursor just above your standard signature (this is important!). 

 

3. Click the Signature button and choose New Signature from File...: 

 
 

4. Your standard signature will now be removed from the email, and you will see this popup 

window: 

 
 

5. Click Browse to find the signature file. 

 

6. Click on OK. 

 

7. The signature will now be added to your email, instead of the standard one. 

Mail conversations 
Just like in Outlook, you can in Notes choose whether you want the emails in a folder to be displayed 

as conversation threads. 

You do this by clicking on the Show button in the upper right corner of the folder, and choose 

Conversations: 
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Notes does have a functionality here that Outlook does not have.  

Whenever you click on an email that is a part of a conversation thread, even if the entire 

folder is set to display Individual Messages, you still get a twisty to the left of the email: 

 

If you click this, you can still see the entire conversation, even if the folder is set to display 

individual messages only. 

Notifications 
Like in Outlook a sound plays, and popup notifications and/or slide in summaries, and an envelope 

icon appear in the taskbar when a new email arrives. 

You can control these notifications by clicking on File -> Preferences and then expand Mail and 

choose Sending and Receiving. Under the section called Receiving you can choose what 

notifications, if any, you want: 

 

Out of office 
Like Outlook, Notes gives you the ability to set up an automatic reply that should go out to people 

who send you an email. In Outlook it's called Automatic Replies, while in Notes it's called Out of 

Office: 
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1. Click the More button above the folder and choose Out of Office...: 

 
 

2. You now get the Out of Office form in Notes. Here you can set the date for when you are 

leaving, whether you are available for meetings (people will see you as busy when checking 

your schedule if you choose not to be), a subject for the automatic reply and the mail 

message itself. 

 

3. You can also set an Alternate notification: 

 
 

By clicking on To, you can choose people from your personal contact list, as well as the 

corporate directory, who should receive an alternate notification.  

 

You can also add emails directly in the field to the right of the To function. You then set an 

alternate subject and message text. 
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4. You can also set up who should not get an Out of Office message from you under Exclusions: 

 
 

In this example I have set that any email sent from hotmail.com you should not get an 

automatic reply. I have also added that any message containing the phrase Nigerian prince 

in the subject should not get a reply either. You add a phrase by entering it in the field A 

message subject contains any of these exact phrases and then click on Add Phrase. To 

remove a phrase, click on it in the big square, and then click on Remove Phrase. 

 

5. When you are finished, you can click Enable and Close at the top to activate the Out of 

Office agent. If you have set it to start at a later date, it won't start sending out automatic 

replies until the selected date and time is reached. If you click Save and Close, you only save 

this as a draft, and it will not be activated. 

Spellchecking your email 
You learned how to turn on and off spellchecking in Notes in the section Notes client settings and 

functions above, as well as how to use it. In this section you will learn the extra functions Notes has 

for spellchecking emails.  

Spellchecking while writing 
Check the spell-checking sub sections in the Notes client settings and functions section above 

Spell-checking before sending 
You can also do a last spell check before sending the email. It will also spell check the Subject line. 

To turn on this feature: 

1. Go to File -> Preferences. 
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2. Choose Mail in the preferences window: 

 
 

3. Make sure the Spell-check messages before sending option is checked under Message 

Options. 

 

4. Click OK. 

When you now write an email and hit send, Notes spell checks the Subject line and the main text 

of the message: 

 

• You can choose which language you want to use as Dictionary. 

• You can skip a word and jump to the next or you can skip all by just clicking Send As Is. 

• You can choose a suggested word from the list, or type your own correction, and then click 

Replace. Notes jumps to the next misspelled word. 

• You can add a word to the Dictionary so that Notes won't claim that it's misspelled the next 

time. 

• You can click Spelling Options... to tell Notes to ignore words in uppercase and with 

numbers. 

When all errors are corrected, Notes sends the email. If you want to skip over spell checking, you can 

click Send As Is. 

Prevent sending emails with blank Subject line 
1. Go to File -> Preferences. 
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2. Choose Mail in the preferences window: 

 
 

3. Make sure the Warn me about blank message subjects option is checked under Message 

Options. 

 

4. Click OK. 

Notes now warns you if you try to send an email without a subject line 

Formatting email text 
Check the Rich text formatting in HCL Notes sub section in the Notes client settings and functions 

section above on how to format text in an email. 

Set default email font 
To change the default font in email: 

1. Write a text with the font that you want to set as a standard font. 

 

2. Highlight it: 
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3. Go to the Text menu and choose Set Current Font as Mail Default: 

 
 

4. Notes confirms your choice: 

 
 

5. Click OK. 

Now Notes uses this font as your default font in emails. 

Add another email account 
Unfortunately, you cannot add another email account to Notes like you can in Outlook. 

What you can do is create group mail applications that you can open like you open your own email. 

You can also be given access to other people’s email, which you then can open like your own mail 

application. 
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However, are opened as separate Notes applications or databases in the Notes client, and not 

collected in the left side menu in your mail, like in Outlook. 

Calendar 
Notes has a very good calendar that you can use to schedule meetings, appointments, and 

reminders. In this section you will learn how to get the most out of the Notes calendar so that you 

can set up your work schedule in the most effective way.  

Share your calendar 
You can share your calendar with other users. 

1. Go to the menu File and choose Preferences. 

 

2. Click Calendar and To do and then Access and Delegation: 
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3. Click Add...: 

 
 

Under Person or Group choose if everyone should have access or just the people or groups 

that you add by clicking in the field to the right of Just this person or group. 

 

Under Components select what they should have access to. 

 

Under Access choose if they only should be able to read your calendar, or if they should also 

be given full access (there's nothing in between). 

 

4. Click OK when finished. 

 

5. You will now see the person and how much access they have in the list under Delegate 

access to these people or groups. 

 

You can later change the access via the Change Access... button or remove the person from the 

access list by clicking on Remove 

Add a shared calendar to your calendar 
To add a shared calendar: 
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1. In the left menu of your Notes calendar, expand Show Calendars and click Add a calendar...: 

 
 

2. This window appears: 

 
 

3. You can now search for a Notes user and then choose the colours you want this user's 

calendar entries to be displayed with.  

 

4. Click OK when finished. 

 

5. To toggle on and off this users calendar, check and uncheck the calendar from the list of 

your calendars: 

 

Colour code calendar entries 
Just like in Outlook, you can also colour code your calendar entries. This means that calendar entries 

matching certain criteria that you set will be colorised so that you can differentiate the various 

appointments with a quick glance. 

You do this by adding a category to a calendar entry: 
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1. When you create a calendar entry, like a meeting, you can add a category by clicking here: 

 
 

If the Category option is not there, click the button Display and choose Category: 

 
 

2. After clicking Category, you see a list of all your categories in a popup window: 

 
 

3. You can add more than one category by checking the checkboxes next to the category title. 

To add a new category, simply type it in the Add category field and hit the Enter key on your 
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keyboard. 

 

4. Click OK. 

 

5. To the right of the Category field, you find an option called Assign Colors...: 

 
 

6. Click it and this popup appears: 

 
 

7. Click one of the buttons that looks like the button the arrow in the illustration above is 

pointing at to select the category or categories you want to give a certain colour. 

 

8. Then choose the background colour and text colour for this category. 

 

9. Click OK when finished. 
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The calendar is immediately updated with this colour. Here is an example of a calendar with colour 

coded entries: 

 

Change calendar views 
In Outlook you choose in the top ribbon menu if you want to see a calendar displayed as a day, 

week, work week, month or as a schedule. 

Period views 
In Notes you use the left side menu item called Views to switch between a day, two days, a work 

week, a week, a month, or weekly planner: 
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Summary or timeslots 
You can switch between viewing the calendar as a summarised calendar or as timeslots by clicking 

on the Switch button in the upper right of the calendar: 

 

Timeslots display the calendar like this: 

 

Week numbers 
Week numbers are displayed in the calendar footer at the bottom of the calendar. To turn on week 

numbers: 

1. Make sure the calendar footer is turned on by clicking on Display and then choose Calendar 

footer: 
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2. The calendar footer will now be visible under the calendar view. Click on the little pulldown 

arrow to choose Week [Number]: 

 
 

You can also do this in Day at a Glance in the right sidebar panel. 

Find available time 

Check one person's schedule 
To quickly check if a colleague is available, rightclick an email from this person, choose the name of 

the person, and then select Find Available Time...: 

 

You will now see a pop-up window where you can select a time where both of you are green and 

then you can click Create Meeting. 

Check the schedule for meeting participants 
If you are creating a meeting, you can check when people you have added to the meeting are free. 

Click the Find Available Times tab, next to Description:  
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If the bar turns green, it means everybody whose schedule you have access to is available. If it's red, 

it means one or more of the invitees are busy at the proposed time. 

M the bar around to change the date and time of the meeting. You can even increase or decrease 

the size of the bar to change the length of the meeting. 

View Invitee Status 
It is very easy to check who has replied to your meeting invite, and whether they have accepted or 

not. Simply open the meeting document and click the button Invitee Status. 

Contacts 
Like in Outlook, you have your own personal Contacts app in your Notes client. In this section you 

will learn how to add contacts and organise them in groups. You will also see how you can take 

control over the addresses that are displayed when you type email addresses into the To field in a 

new email. 

Add contact 

From Mail 
You can add a contact from an email by right clicking on the email and choose Add Sender to 

Contacts....  

A popup window appears with the email address and name fields filled out. You can then add more 

details if you want.  

After clicking on OK, the contact is added to Contacts. 

From Contacts 
Open your Contacts application and click the My Contacts item in the left side menu and then simply 

click the New button above the contacts’ view. A popup window will appear where you can add 

some basic information about the new contact. 

If you want to fill in more details about a new contact, click on the pulldown arrow to the right of the 

New button and choose Contact. A form now appears where you can add a lot of details about the 

new contact. 
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Create contact group 
You can also organise your contacts into groups. 

1. Open your Contacts application and click the Groups item in the left side menu. 

 

2. Click the button New in the upper left corner above the Groups folder: 

 
 

3. Give the group a name and a description: 

 
 

4. Go to the field Members. 

 

5. Start typing the name of the contact you want to add. Notes suggests names from already 

existing contacts. Click the one you want and click the enter key on your keyboard to start 

adding a new one. You can also add the email address of contacts that aren't in your 

Contacts register. Just type the email address and hint the enter key.  

 

You can also click Members. You then see this popup: 

 
 

You can now select people from your company directory.  

 

If you want to add people from your personal Contacts, change to your contact application 
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in the Directory pull down field: 

 
 

You can use the Find names starting with field to type the beginning of a person's name to 

find the person you are looking for, if you do not want to scroll through the list. 

 

Click OK. 

 

6. Click Save and Close. 

You can now use the group when sending emails or meeting invites. 

Recent contacts 
When you create a new email and start typing the address or name of a person in the To, Cc or Bcc 

field, Notes suggests names and addresses for you: 

 

Sometimes Notes suggests email addresses or contacts that you do not want to see in the 

typeahead. You can fix this in Contacts: 

1. Open Contacts. 

 

2. Click the Recent Contacts item in the left side menu. 

 

3. Find the address or person you do not want to see in the typeahead anymore and click him 

or her. 

 

4. Now click the button over the view called Hide in Typeahead 

It will now no longer show up in in the typeahead. If you want it to show up again, you just repeat 

step 1-3 and then click Show in Typeahead in step 4 

To do 
In Outlook you have an application called Tasks. In Notes this is called To do. 

Create a To do 
As described under the section Mail, you can turn an email into a To do, just like in Outlook. But you 

can also create a To do from scratch: 
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1. Open the To do application. 

 

2. From any folder inside To do, you can click the New button in the upper left corner above 

the folder. This form appears: 

 
 

3. You can set a priority, a due date, a start date and whether this is a To do that should be 

repeated or not (if you click on Repeat you can choose a whole range of repeating patterns). 

You can also assign this To do to another person.  

In addition, you can categorize it and add further details in the rich text field Description. 

 

If you choose a due date, an option called Notify Me will appear in the upper right corner of 

the form: 

 
 

If you click the clock icon you can choose when you should be notified, and how. 

 

4. Click Save and Close when finished. 
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Mark a To do as completed or incomplete 
To mark a To do as completed, simply right click it and choose Mark Complete. You can also open it 

for editing and click the button Mark Complete. 

You mark a completed To do as incomplete in the exact same way.  

To see your completed To dos, click the menu item Complete in the left side menu in the To do app. 

Conclusion 
In this document you have seen how you can ease the transition moving from Outlook to Notes. You 

have also mastered how to use the settings in the Notes client and how to use the standard 

applications Mail, Calendar, Contacts and To do, so that Notes works best according to your needs. 

The next step would be to dive even deeper into how to use email and calendaring, and maybe even 

give the users some tips on how to set up their own Notes/Domino low code applications.  

Resources 
Go to the following resources to learn more: 

• Hogne B. Pettersen’s Notes tips 

• HCL Notes documentation 

• HCL Notes/Domino forums 

• HCL Notes/Domino blogs 

• HCL Notes/Domino product’s page 

  

https://domino.elfworld.org/tag/notes-tip/
https://help.hcltechsw.com/notes/welcome/index.html
https://support.hcltechsw.com/community?id=community_forum&sys_id=cd74744e1b16f340c48197d58d4bcb66
https://blog.hcltechsw.com/domino/
https://www.hcltechsw.com/products/nd

